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User Guide 

Please review this document thoroughly prior to using the HIT System™. 
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FCC Compliance Regulatory Statements 

 
These FCC statements apply to SIDELINE RECEIVER and MxENCODER: 
 

Compliance Statement ( Part 15.19 ) 
The SIDELINE RECEIVER and MxENCODER devices comply with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions: 
1. These devices may not cause harmful interference, and 
2. These devices must accept any interference received, including interference that may 
cause undesired operation. 
 
Warning ( Part 15.21 ) 
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment. 

 
SIDELINE RECEIVER 

RF Exposure ( OET Bulletin 65 ) 
To comply with FCC’s RF exposure limits for general population / uncontrolled exposure, the 
antenna(s) used for this transmitter must be installed to provide a separation distance of at least 
20 cm from all persons and must not be co-located or operating in conjunction with any other 
antenna or transmitter. 

 
MxENCODER 

This device and its antenna has shown compliance with FCC’s SAR limits for general population / 
uncontrolled exposure for a portable device.  The maximum listed SAR level is 1.27 W/kg (head).  
The antenna used for this device must not be co-located or operating in conjunction with any 
other antenna or transmitter. 

 
 
Industry Canada Statement 

The term “IC” before the certification/registration number only signifies that the Industry Canada 
technical specifications were met. 
 
SIDELINE RECEIVER 

Section 5.5 of RSS-210 
This device has been designed to operate with an antenna having a maximum gain of 5 dBi using 
an omni directional antenna.  Antenna having a higher gain is strictly prohibited per regulations 
of Industry Canada.  The required antenna impedance is 50 ohms. 

 
Section 5.11 of RSS-210 
To reduce potential radio interference to other users, the antenna type and its gain should be so 
chosen that the equivalent isotropically radiated power (EIRP) is not more than that required for 
successful communication. 

 
MxENCODER 

Section 14 of RSS-210 
The installer of this radio equipment must ensure that the antenna is located or pointed such that 
it does not emit RF field in excess of Health Canada limits for the general population. 
Consult Safety Code 6, obtainable from Health Canada’s website:  www.hc-sc.gc.ca/rpb. 
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INTRODUCTION 

 

Trainers, coaches and officials of contact sports have long sought to protect players 

from head injury.  But, in hard-hitting sports like football, what can be done?  The best 

equipment, coaching and enforcement of the rules cannot completely protect against 

mild brain trauma and concussion.  Potential injury-producing impacts can go unnoticed 

and the resulting physiological damage may even be cumulative.  Groundbreaking 

technology developed by Simbex and supported by the National Institutes of Health 

could change all that.  The system is called the Head Impact Telemetry System™ (HIT 

System™) and is the first device to continuously monitor, analyze and record a player’s 

on-field head impact experience, and which is practical enough to be used in all game 

and practice situations.   

 

The HIT System not only monitors and records the impact history for all players 

simultaneously, but also can signal the sidelines staff to the occurrence of an impact 

that conforms to a Suspect Impact Profile™.  The system monitors standard impact 

measures, such as maximum g’s, Head Impact Criteria (HIC), and Gadd Severity Index 

(GSI), or customized metrics based on any of the following components: 

• Impact location   

• Impact magnitude  

• Impact duration 

• Linear and angular acceleration components 

• And the exact times,  

of single or multiple impacts for improved player protection from serious injury.   

 

About Simbex – 

                                  “Simply Better Exercise”  

The Head Impact Telemetry System has been developed and patented by Simbex.  

Simbex has been researching, testing and creating products that benefit active people 

since its inception.  Simbex is a research and product development company, 

specializing in biomechanical feedback systems, with research awards from the National 

Institutes of Health and the National Science Foundation.  Our goal is to bring to market 
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the most innovative products and timely solutions for “active life improvement” in the 

areas of prosthetics, rehabilitation, and injury prevention.  

 

It is our sincere hope that Simbex, our research / development partners and this 

technology will combine to make contact sports safer for all players.   

 

For more information, please visit us on the web @ www.simbex.com. 

 

The Basics 

 

Please read this User’s Guide completely before set-up and use of the HIT System.  If you 

need assistance with your first use of the system, please call Simbex Technical Support at 

the number listed in the CONTACT INFORMATION section.   

 

The HIT System™ is comprised of four main 

systems: the MXEncoders, the Sideline Receiver, 

the Alert Pager, and the Computer.  The Sideline 

Receiver, Alert Pager, and Computer are all stored 

within a protective Field Case.  The MX Encoders 

are installed inside Riddell VSR-4 and Revolution 

football helmets, measure impacts as they occur on 

the field, and transmit impact data to the Sideline 

Receiver.  The Sideline Receiver manages impact 

information recorded by the MXEncoders and relays 

it to the Computer, where the data is processed, 

analyzed, and stored.  When impacts matching 

user selectable Suspect Impact Profiles (SIP’s) are 

received, the Alert Pager System sends a signal to 

the Alert Beeper, signaling sideline staff that a SIP 

has occurred. 

 

 
Figure 1: The HIT System™ 

(Alert Pager not shown) 

Field Case 

Sideline Receiver

Computer

MXEncoder in 
VSR-4 Helmet
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When the HIT System™ is initially received, the MXEncoders must be installed in 

helmets and all system batteries must be charged.  Once these two steps are complete, 

the HIT System™ is ready to be setup out on the field and begin recording impacts. 

 

INITIAL SETUP 

Field Case 

 

The HIT System™ is supplied within a protective field case, designed to make the HIT 

System™ easy to use on and off the field, provide convenient storage for all system 

components, and protect HIT System™ electronics from adverse weather conditions.  

Upon opening the field case, the laptop computer, the Sideline Receiver, and the 

Sideline Receiver Stand are visible.  The Alert Pager is stored in a compartment beneath 

the computer.  Access to this compartment is gained by removing the panel underneath 

the computer, although this is not necessary during normal use conditions.    

 

The field case is factory configured with internal power outlets and data transfer 

connections (Figure 2).  Power is provided to the case via an external plug (power entry 

module); when the case has been connected to a 120V source the Alert Pager and 

power supply for the computer are automatically energized.  Spare 5A fuses for the field 

case power entry module may be found in the bottom of the field case.  The case also 

has an external data port used to relay information from the Sideline Receiver to the 

computer.  

 

A Sideline Receiver antenna mast is included in the Field Case.  The antenna mast 

mounts directly to the left side of the field case by inserting the antenna base into the 

notched key holes.  The antenna is mounted onto the Sideline Receiver by inserting the 

antenna base into the Sideline Receiver antenna jack.  For optimal range, the mid-shaft 

of the Sideline Receiver antenna should be mounted 5 feet from the ground.   
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The computer is supplied installed inside the field case; the computer and its power 

supply are connected to the internal power strip of the field case.  Connecting the field 

case to external power will initiate charging of the computer batteries.    Allow 8 hours 

to completely charge the computer batteries before first use of the HIT System.  

If the laptop has been subsequently removed from the field case, it will be necessary to 

ensure the computer is connected to its power supply. 

 
 
 
Figure 2: Field Case Wiring Diagram  
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Battery Charger Case 
 

The HIT System™ MXEncoder is powered by rechargeable batteries, which must 

receive a complete charge prior to first use.  It is also recommended that all 

batteries receive a full charge prior to each subsequent use.  Charging of the batteries 

may be accomplished by: 

 

1. Connect MXEncoder batteries to the 

chargers located in the charger case, and 

position the batteries in the cutout next to 

each charger.  Up to 4 batteries may be 

connected to each charger.  Depending on 

configuration, each charger case may 

charge up to 24 batteries. 

2. Once all connections have been made, 

connect the charger case with external 

power. 

3. Confirm that batteries are charging; red 

LED indicators on each charger will light when the charger is operating.  (It is 

necessary to lift the chargers on one side of the case from their nest to confirm 

LED status.) 

4. Allow 8 hours to charge fully. 

 

Important:   

1. Connect all batteries to be charged at the beginning of the charge cycle.  

The chargers operate on a timed 8-hour cycle; the cycle begins when the first 

battery is connected to a charger that has power, or when a charger that has 

batteries connected is plugged into external power.    The charger first drains the 

batteries fully, then charges them fully each cycle.  Batteries that are connected 

to the charger mid-way through the charge cycle will not receive a full charge.   

2. Do not close the charger case lid while charging.   

 
Figure 3: Charger Case 
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3. The battery-type selector switch on the chargers has been disabled; the charger 

may only be used to charge NiMH-type batteries that are supplied with the 

HIT System. 

 

MXEncoder Installation 

The MXEncoders (P/N 02-23000) are designed 

specifically to fit Riddell model VSR-4 size Large helmets.  

To ensure player safety and proper measurement 

performance, please consult with Simbex prior to using 

the MXEncoder in other helmet applications. 

 

To install MXEncoders in each helmet: 

 

1. Remove the thin layer of padding (G) from 

between the Top Pad (A & B) and the Temple 

Pads (H).  

2. Separate the two large Velcro strips which are 

attached to the back of the MXEncoder.  

Remove the adhesive backings from the loop side 

and adhere to inside of the helmet where 

pads (G) were just removed. 

3. Flip the Forehead Pad (D) up and out of the 

helmet. 

4. Detach Temple Pads (H) and lift up.  Install 

MXEncoder, one side at a time, and position to 

be symmetrical about the centerline of the 

helmet.  Replace the Temple Pads (H). 

5. Replace the Forehead Pad (D). 

 

Figure 3: Pad Diagram for 
Riddell VSR-4 Helmet 

 
Figure 4: Helmet w/ Forehead 

Pad removed, Velcro  

Figure 6: Completed MX 
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PRE-GAME SETUP 

 

Configuration and setup of the HIT System is easily completed in about 10 minutes prior 

to the beginning of play each day.  Setup may be completed by accomplishing the 

following steps: 

 

HIT System Setup 

1. Remove the Sideline Receiver and Sideline Receiver Stand from the Field Case. 

2. Unlock the clamps on the Sideline Receiver Stand, fully extend the telescoping 

stand legs, and lock the clamps in place. 

3. Slide the keyhole plate on the bottom of the Sideline Receiver Stand over the 

posts on the left side of the Field Case and lock in place.  

4. Screw the Sideline Receiver onto top of Sideline Receiver Stand.  Adjust height 

so that the base of Sideline Unit is approximately 5 feet above the ground. 

5. Connect the Sideline Receiver Cable to the Data Port on the outside of the Field 

Case. 

6. Connect the Field Case to a 120V source. 

 

Important:  The HIT System Computer and Sideline Receiver will operate for ~3 hours 

on the computer battery if fully charged.  The Alert Pager will not operate unless 

the field case is connected to a 120V source on the field.  For best results, it is 

recommended to have a 120V source connected to the HIT System at all times during 

use. 

 

Software Initialization 

1. Turn on the computer by pressing the power button located centrally above the 

keyboard. 

2. Login to the HITS User Profile: Click on HIT System → (Leave the Password field 

blank) → Enter. 

3. Run the HITS™ Software by clicking on the HITS™ Software icon either on the 

desktop or in the Start → Programs → Head Impact Telemetry System. 
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4. When the HITS™ Software loads, the ON light (green LED) on the bottom of the 

Sideline Receiver begins to blink, indicating that the system is functioning. 

 

Important: For best results, the Sideline Receiver and Software should be setup and 

run first, which will allow verification that MXEncoder communication with the Sideline 

Receiver has been properly established as the MXEncoders are brought online.  

Connecting the batteries to the MXEncoders effectively turns them on; each time they 

are turned on they must receive configuration instruction from the Sideline Receiver.  

MXEncoders are properly configured and communicating with the Sideline Receiver 

when the Player Circles turn from red to green upon initial startup.  Once this occurs, 

the players are ready to measure and record impacts to the onboard memory.  During a 

practice or game, MXEncoders may periodically lose communication with the Sideline 

Receiver.  Once communication is reestablished with the Sideline Receiver, all available 

impacts are downloaded to the computer and saved.  In the unlikely event that 

communication is not re-established, up to 100 impacts will be stored onboard the 

MXEncoder.  These impact data will be stored until they are successfully downloaded to 

the Sideline Receiver; data integrity will be preserved if power is lost to the MXEncoder 

(i.e. battery change).         

 
 
MXEncoder Battery Pack Installation 

The MXEncoder Battery Packs need to be installed into the 

helmets prior to each use.   

1. Hold open the MX Encoder Velcro straps and place 

battery pack in the gap between straps with the 

Velcro patch facing towards you.   

2. the MX Encoder. Position the connector between 

the battery pack and the helmet pads. 

3. Close Velcro straps over the battery pack and 

connector to secure in place.  
Figure 7:  Battery Pack 

Installed 
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Important:  Low MX Encoder battery power is indicated in the software when the 

corresponding player circle turns from green to yellow.  The MX Encoders will 

continue to function normally for 1-2 hours in this condition; the player circle will 

turn red when battery power is lost.  Any impact data recorded but not yet downloaded 

when power is lost will be preserved until power is regained and data can be 

downloaded. 

 

Once these simple steps have been taken, the HIT System™ is ready to record impacts.  

Put on the helmets and play ball.  The HITS System™ will keep a detailed record of each 

impact recorded. 

 

SOFTWARE GUIDE 

While the HITS™ Software is running, it is continuously downloading, processing, and 

saving all available impacts from configured MXEncoders.  The software has two 

operational modes, Real-Time Mode and History Mode.  Real-Time Mode displays the 

most current impact information on the field as it is received, while History Mode allows 

the user to review the daily impact history for any single player. 

 

Layout 

The HITS™ Software loads in Real-Time Mode and brings up the main control window, 

shown in Figure 8 below. 

 

The player list shows numbers that correspond to the specific hardware identification 

numbers of the MX Encoders in each helmet.  This list may be customized (i.e. to show 

numbers corresponding to the actual player number) by editing the team.ini file, found 

in C:/Program Files/Simbex HITS.   The format of the team.ini file is as follows: 

[TEAM NAME] 
PlayerNum HWUnit 

1,301 

18,318 

17,317 

23,323 

24,324 
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The name inside the brackets may be edited; this is the team name that appears in 

exported data files.  The first number of the two number string is the number that will 

appear in the player circle; these numbers must be unique, are limited to two digits in 

length, and numbers 1-9 must be expressed as “1”, as opposed to “01”.  The second 

number is the hardware address of the MX encoder corresponding to that player, and 

should not be changed.  Under no circumstances should any other .ini files be edited as this 

may cause a serious system malfunction. 
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Figure 8: HITS™ Software – Real-Time Mode 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Command Menu – 
Access functional 
commands: Export, 
Exit, Configure Team 
(not currently 
available), Frequency 
Auto-Set, Frequency 
Manual Set, Help 
Contents and About 

Current Impact – An arrow 
points to the location on the 
head where the last impact 
was received.  In Real-Time 
Mode, the last impact received 
is shown.  In History Mode, 
the impact highlighted from 
the Past Hits List is shown.  
Below the head is a plot of the 
acceleration magnitude of 
each individual sensor in color; 
cumulative CG acceleration is 
shown in black.

Cumulative Impact –
Arrows point to the location on 
the head of each the impact 
received.  In Real-Time Mode, 
every hit from that day is 
shown.  In History Mode, all of 
the impacts from that day of 
the highlighted player are 
shown.  Below the head is a 
bar graph with the maximum 
CG acceleration of each 
impact. 

Temperature – Displays 
the temperature inside the 
helmet of the last impact 
received. 

Player List – Each 
numbered circle 
represents a player.  When 
the circle is green, there is 
clear communication with 
that player.  When the 
circle is red, that 
communication is not 
established.  In the event 
of no communication, MX 
Encoders will continue to 
collect data (up to 120 
impacts).    

Status Bar – Displays 
messages regarding the 
current status of the 
application. 

Past Hits List – A list of 
all of the impacts received 
by the highlighted player 
that day.  Each hit is 
labeled with the time of 
occurrence. 
(HH:MM:SS:mSec) 
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Figure 9: HITS™ Software History Mode 

 

 

 

Software Use 

Once the software is up and running, it will continuously record all impacts.  The most 

recent impact will show in the Last Impact window with an arrow pointer to the location 

on the head where the impact was received.  The green button corresponding to the 

player who received the impact will appear depressed, indicating that this player was the 

recipient of the impact displayed on the screen.  The headforms in both display widows 

can be manipulated using the mouse and keyboard:  

• Left-click & drag to rotate the headform about its CG 

• Shift-Left-click & drag to translate the headform in any direction 

• Ctrl-Left-click & drag to Zoom-In or Zoom-Out  

To enter History Mode click on any player circle from the player list.  If impact data are 
available for that day, the Past Hits List is filled with the timestamp corresponding to each 
impact.  Double clicking on any timestamp will display the data for that impact.  In History 
Mode, MXEncoder data are still downloaded, processed, and saved in the background..  Click 
the Return to Real-Time button to return to real time mode 
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All of the current day’s impacts are displayed in the Cumulative Impact window, with a 

bar chart below displaying the magnitude of each.  These data are associated with the 

Current Impact player number. To examine a specific impact that an individual player 

has experienced, click on the player’s circle in the Player List to enter History Mode.  All 

of that player’s impacts for the day will be shown in the Cumulative Impacts window.  In 

addition, a list of the impacts labeled with the time (HH:MM:SS:mSec) at which the 

impact occurred will be displayed in the Past Impacts List window.  Double click on a 

specific impact in the Past Impacts List window to examine the details of that impact.  

To return to Real-Time Mode, click on the “Return to Real-Time” button. 

 

The Alarm Pager alerts the sideline staff if an impact or temperature event exceeds a 

pre-defined threshold.  Impact and temperature thresholds can be modified in the 

Beeper.ini file – these thresholds will be applied to all MXEncoders.  Alert messages 

received by the pager have a simple format of “Player xx: Message type Event Value” 

where Message type will either by Impact Thres, Temp Thres, or Crit Temp and 

Event Value is the value associated with the alarm.  Crit Temp is the temperature of the 

MXEncoder that is 3 deg above the standard Temp Thres. Use Test Event Beeper 

under the Tools menu item on the menu bar to test the Alarm Transmitter and Pager.  

Once executed, a simple message (Player 0: FALSE ALARM 0.0) should be received by 

the Alarm Pager within 5 secs.     

 

The Impact Qualification menu option is used to activate/deactivate a neural-network 

based algorithm to determine whether impacts are valid or invalid.  The impact 

qualification only takes place on data that is being sent to the Alert Pager to minimize 

the occurrence of false impacts.  The algorithm was developed using data collected by 

Virginia Tech during the 2003 season.  As more data are collected and analyzed, the 

algorithm will get better.  There may be times throughout the season where we may 

need to upgrade the algorithm to provide a better service to our users. 

 

In the unlikely event of wireless communication failure, impact data are still recorded 

onboard the MXEncoder and can be retrieved later in an environment with “cleaner” air.  
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The data are stored on the MXEncoder in non-volatile memory and won’t be erased until 

instructed to by the HITS Software. 

 

Communication between the MXEncoder and Sideline Receiver is sensitive to 

environmental noise (i.e. other devices operating in the ISM band).  The communication 

link between the MXEncoder and Sideline Receiver is designed to be frequency agile, 

automatically switching between various frequencies to avoid any interference.  The HIT 

System operates in the FCC unlicensed ISM band (902-928 MHz).  Typical range is 

expected to be <= 150 yards. 

 

Data Analysis 

 

A detailed CG (Center of Gravity) time series for any single impact may be exported to 

an ASCII text file for further data analysis: 

1. Select the Export command under the File Menu.  This will bring up an Export 

dialog box (Figure 10). 

2. Select the date on which the impact occurred, the player number and the impact 

ID number (which is the time the impact occurred).  Once the specific impact is 

highlighted, a graph of the raw data will appear.  A few moments later the 

processed CG time series will appear in the graph window as a thick white line.  

The impact vector (magnitude, azimuth, and elevation direction) are detailed in 

the Impact Vector text boxes.  Head Impact Criterion (HIC) and Gadd Severity 

Index (GSI) metrics will also be illustrated.  Note that these metrics are 

calculated using Simbex chosen metric parameters; only the CG time series is 

exported to the data file.  The exported CG time series data should be used with 

the user’s preferred algorithms to calculate metric measures.        

3. Once the desired impact has been chosen, press the Export button, which will 

bring up a Save As dialog box.  

NOTE:  Qualification of impact data is not supported in this feature and may 

be included in future releases.  All impact data are currently available.  

4. Save the file in the desired location.  The exported ASCII data file will contain a 

header with impact information (date, time, player number, impact vector, and 
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CG time series).  This file is tab delimited and can be easily read into commonly 

used analysis programs. 

 

Figure 10: Export Dialog Box 

 

 

POST-GAME BREAKDOWN  

 

When practice session or the game is over, breakdown and storage of the HIT System is 

easily and quickly accomplished by completing the following steps:   

1. Exit the HITS™ Software by clicking on the Exit command in the File menu. 

2. Shut down the laptop computer. 

3. Disconnect the Field Case from 120V source and store cord in the space behind 

the computer. 

4. Unplug the Sideline Receiver Cable from the Field Case and unscrew the Sideline 

Receiver from the Sideline Receiver Stand.   

5. Collapse the Sideline Receiver Stand and return to the Field Case.   

6. Return the Sideline Receiver to the Field Case.   

7. Bring the Field Case inside and using the extension cord, plug it into a wall 

outlet.  Ensure that the computer charging light is on, then close and lock the 

Field Case. 

8. Remove all of the batteries from the helmets and connect them to the chargers 

within the Charger Case.  Follow instructions for battery charging above. 
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MAINTENANCE 

Periodically impact data will need to be downloaded to the Simbex Network, and 

updates to the HITS™ Software may be released.  The Simbex Technical Support team 

will perform these services by remotely accessing the Laptop Computer.  In order to do 

this, the Laptop Computer will need to be connected to the World Wide Web and its IP 

address will need to be supplied to Simbex Technical Support. 

 

TROUBLESHOOTING 

∇ HITS™ Software will not load. 

 Corrective Action: 

 Call Simbex Technical Support. 

∇ HITS™ Software “Does not detect a Sideline Unit.” 

 Corrective Actions: 

 Check that all of the serial cable connections are firmly connected. 

 Close the software and restart it. 

 If that fails to work, the batteries in the sideline unit may be dead.  

Try recharging the Sideline Unit. 

 If the HITS™ Software still “Does not detect a Sideline Unit,” call 

Simbex Technical Support. 

∇ HITS™ Software does not recognize a specific Helmet Unit. 

 Corrective Actions: 

 Unplug the helmet battery.  Wait 5 seconds.  Plug battery back in. 

 If that fails to work, call Simbex Technical Support. 

∇ Battery or antenna cables come loose. 

 Corrective Actions: 

 Contact Simbex Technical Support for replacement parts. 

Contact Information 

phone: 1-877-2SIMBEX  
fax: 1-603-448-0380     
email: info@simbex.com 
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